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School of Computer Sciences 

Bachelor of Science (Computer Science) 

 

 

1. Structure: 
 

Course 

Code 
Course Title Credits 

Marks Distribution 

Spot 

Assignment 

(Internal) 

Term End 

Exam 

(External) 

Total 

FIRST YEAR: 

BFTM 11 Tamil [or] any one of the 

other languages 

6 25 75 100 

BFEG 11 English Language 6 25 75 100 

BCM-01 Mathematics  4 25 75 100 

BSCS-04 Introduction to Computer 

Organisation 

4 25 75 100 

BSCS-05 ‘C’ Programming and Data 

Structures 

4 25 75 100 

BSCS-06 Visual Basic Programming 4 25 75 100 

BSCS- P1  Lab 1: ‘C’ & VB 

Programming 

 

4 25 75 100 

SECOND YEAR: 

BSCS-07  Applied Operations Research  6 25 75 100 

BSCS-08 Design and Analysis of 

Algorithms  

6 25 75 100 

BSCS-09 Object Oriented Programming 

with C++  

4 25 75 100 

BSCS-10 Introduction to Database 

Management Systems 

4 25 75 100 

 Elective I * 4 25 75 100 

CCE Environmental Studies 4 25 75 100 

BSCS-P2 Lab 2: C++ Programming &  

RDBMS  

4 25 75 100 

THIRD YEAR: 

BSCS-15 Data Communications and 4 25 75 100 
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Networking 

BSCS-16 Introduction to Operating 

Systems 

4 25 75 100 

BSCS-17 Java Programming  4 25 75 100 

BSCS-18 HTML & Web Design 4 25 75 100 

BSCS-19 Introduction to Software 

Engineering 

4 25 75 100 

 Elective II ** 4 25 75 100 

BSCS-P3 Lab 3: Java Programming  4 25 75 100 

BSCS-P4 Project Work 4 - 100 100 

ELECTIVE I: 

BSCS-11 Accounting and Financial 

Management 

4 25 75 100 

BSCS-12 Management Information 

Systems 

4 25 75 100 

BSCS-13 Principles of Management 4 25 75 100 

BSCS-14 Managing Information 

Technology 

4 25 75 100 

ELECTIVE II: 

BSCS-20 Network Security 4 25 75 100 

BSCS-21 Software Testing  4 25 75 100 

BSCS-22 Compiler Design 4 25 75 100 

BSCS-23 TCP/IP Programming 4 25 75 100 

BSCS-24 Intranet Administration 4 25 75 100 

 

* Students are advised to choose any one Elective Course from list of Elective I  

** Students are advised to choose any one Elective Course from List of Elective II 
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2. Syllabus 

 

FIRST YEAR 

 

BCM - 01: Mathematics 

Block 1: Theory of equations – imaginary roots rational roots – Relation between the roots and 

coefficients of equations – symmetric function of the roots – sum of the power of the roots of an 

equation – Newton’s Theorem. Transformation of equations: Roots multiplied by a given 

number – reciprocal roots – reciprocal equations – standard forms to increase and decrease the 

roots of a given equation by a given quantity – Removal of terms. 

Block 2: Solutions of algebraic equations – bisection, Iteration method – Newton – Raphson 

method – Method of False Position. Solutions of simultaneous linear equations: Gauss’s method 

– Gauss Jordan method – Iteration method – Gauss’s Seidal method. 

 

Block 3: Set, Relations and Functions: Sets – Notation and description of sets – subsets – 

operations on sets – Properties of set operations – Relations: Representation of a relation – 

Operations on Relations – Equivalence Relation Partitions and Equivalence Classes. Functions: 

Definition – One to one – Onto functions – Special type of functions – Invertible and 

composition of functions. 

 

Block 4: Finite Automata and Languages: Languages: Alphabet, Strings, Operations, Regular 

Expression: Operation, Non-deterministic Finite Automata – Deterministic Finite Automata. 

 

References Books: 

1. Introduction to Methods of Numerical Analysis, S.S. Sastry, Prentice Hall of India, 1994. 

2. Algebra, T.K. Manicavasagam Pillai, T. Natarajan and K.S. Ganapathy, S. Viswanathan Pvt 

Ltd, 1996. 

3. Discrete mathematical structures with applications to Computer Science, J.P.Tremblay and 

R.Manohar, Tata McGraw Hill, 1997. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page 4 of 26 

 

BSCS-04:  Introduction to Computer Organization 

 

Block-1:  Data Representation: Introduction – The Von Neumann Architecture – Generation of 

Computers – Data Representation: Decimal – Alphanumeric – Fixed – Decimal Fixed – Floating 

point – Error Detection and Correction codes – Instruction Execution.  Digital Logic Circuits – 

Introduction – Boolean Algebra – Logic Gates – Combinational Circuits – Sequential Circuits – 

Inter connection structures.  

 

Block-2:  Peripheral Devices: Memory Organization:  Introduction – various memory devices – 

Types of Random Access Memory – Types of Auxiliary memory – High Speed Memories : 

Cache Memory – Interleaved Memory – Associated Memory.  IO Organization: I/O Model – I/O 

Techniques – DMA – I/O processes – External Interface. 

 

Block-3:  Instruction Set: Introduction – Characteristics – Addressing Modes – Instruction 

format – Examples.  Registers organization: Structure of CPU – Register Organization – Micro 

operation – ALU Organisation – Control Unit Organisation – Microprogrammed Control Unit – 

Microinstruction:  sequencing – Microinstruction Execution. 

 

Block–4: Microprocessor and Assembly Language Programming : Introduction – 

Microcomputer architecture – CPU components – Instruction set – Introduction to Motorola 

68000 microprocessor – Assembly Language : Introduction – Assembly language fundamentals 

– I/O services – Assembly language program development tools – Examples : COM programs – 

EXE programs – Simple assembly language programs – Programming with loops and strings – 

Arrays – Modular program – Interface to high level program – Interrupts. 

 

 

Reference Books: 

 

1. Computer System Architecture, Mano M.Morris, Prentice Hall of India, Third edition,  

(1983) 

2. Microprocessors and Interfacing – Programming and Hardware, Doughlas V.Hall,  

McGraw Hill, 1986 

 

 

 

 

 

 

 

. 
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BSCS-05: ‘C’ Programming and Data Structures 

 

Block 1: Introduction to C programming language – Data types – Identifiers – Variable 

declaration – Enumerated data types – typedef statement – Operators : Arithmetic – relational – 

logical – cast – increment – decrement – bitwise – precedence of operations – expressions – 

decision structures : goto – if – Escape sequences – Structure of C program. 

 

Block 2: Control structures: while – do.. while – if then else – switch – for loops – default 

statement – Arrays : One – multi  dimensional – Declaration of array structure – Simple 

programs  - Size of operators – Storage classes and scope – Functions : Function declaration – 

Prototyping – Pointers – Pointer variable – Pointers as function argument – One, multi 

dimensional arrays as function arguments. Files – Files I/O – Structures – Unions. 

 

Block 3: Data Structures: Introduction – arrays – representation of arrays in memory – sparse 

array – Lists: Basic concepts – Implementation of Lists – Doubly linked list – Circular linked list 

– Garbage collection – Stacks and Queues: Stack operations – Array and pointer implementation 

of stacks – Application of stacks – Queue operations – Implementation of queues – Application 

of queues.  Graph: Basic Terminology – Representation – Traversals - DFS – BFS – Shortest 

path problem – Minimal spanning tree. 

 

Block 4 : Trees : Concepts – Binary tree – Binary Tree traversals – inorder – preorder – 

postorder – Binary search tree (BST) – BST operations – Balanced Tree. Searching: Linear 

search – Binary search. Sorting: Definition – Sorting techniques: Insertion – Bubble – Quick Sort 

– 2 way merge – Heap – Data Storage: Magnetic Tapes, Disk – Sorting with disk and tape – 

Buffering. 

 

 

Reference Books:  

 

1. Programming in ANSI C, E Balagurusamy, Tata McGraw-Hill, 2004. 

2. Fundamentals of Data Structures, Ellis Horowitz, Sartaj Sahni, Computer Science Press, 

1976 
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BSCS-06: Visual Basic Programming 

 

Block 1: Introduction to Windows Programming and Visual Basic: Components of Windows 

Programming :  Graphical User Interface –  Window and its elements – Dialog Box – Drop-

Down and Pop-Up menus – Visual Basic –  Event-Driven Programming – Steps in Building a 

Project – User Interface Design – Writing Code – Visual Basic IDE – Creating and Running a 

simple project 

 

Block 2: Visual Basic Forms and Controls: Form – Tool Box controls – Property window – 

Design and Run-time properties – Events – Keyboard, Mouse, Code and System events – Visual 

Basic Object oriented programming –  Creating buttons at run-time through object declaration - 

Screen, Printer, Error Objects  

 

Block 3: Visual Basic Programming: Visual Basic Data Types -  Constants: predefined constants 

– User-Defined constants – Variables – Scope Rules – Control Structures – If – Select Case – 

Loops – FOR , DO, WHILE loops – Goto – On Goto statements – Event procedures – User 

defined procedures – Library functions – Numeric, String, Boolean and miscellaneous functions 

– Sub Main() procedure – User-defined functions –  Public, Private Scope rules – Creating EXE 

files – Arrays – User-defined data type – Type statement – Control Arrays – Graphics handling – 

Using multiple forms – Activating a form – Multiple Document Interface – A simple MDI 

application  

 

Block 4: Visual Basic Advanced Features: Creating a Database in VB – Accessing an external 

database with Data Control – Object Linking and Embedding (OLE): Linking and embedding an 

excel worksheet with VB project – Using third-party controls in VB - Creating an Active X 

control project – Activating other applications from VB – Windows Application Program 

Interface functions (WINAPI) 

  

Reference Books: 

1. An Introduction to Programming using Visual Basic, David I. Schneider, Prentice Hall, 

1995 

2. Ready-to-Run Visual Basic Algorithms, Rod Stephens, J. Wiley Publication, 1998 

3.  “Visual Basic 6 from ground up” Garry Cornell, TMH, 1999. 

 

 

 

BSCS-P1: Lab 1: ‘C’ and VB Programming  
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SECOND YEAR 

 

BSCS-07:   Applied Operations Research 

 

Block 1 : Operations Research: Scope – Mathematical Models – Linear Programming – 

Graphical Method- Simplex Method – Big –M Method- Two Phase Simplex Method.  

 

Block 2: Programming Techniques: Goal Programming – Integer Programming – Dynamic 

Programming. 

 

Block 3: Sequencing Models: N Jobs on two Machines-N Jobs on Three Machines- N Jobs on M 

machines. 

 

Block 4: Replacement Models: Replacement of Machines without considering the value of 

money- Replacement of Machines with Considering the value of Money- Group Replacement 

and Individual Replacement Policy.  

 

Reference Books: 

 

1. Operations Research, An Introduction, Hamdy A.Taha, PHI, 7th Edition, 2004 

2. Operations Research, Kantiswarup, Guptha and Man Mahon, S. Chand & Sons, 1987 

3. Operations Research An Introduction, Prem kumar Gupta and D.S Hira, S.Chand & 

Company. 

4. Linear Programming, G. Hadley, Narosa Publishing House, 1995.  
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BSCS-08:  Design and Analysis of Algorithms 

 

Block 1 : Introduction to Algorithms and its Development :  Introduction - Algorithms – Basic 

Tools : Top-down structured Programming – Program Correctness – Example : The Knight’s 

Tour- Basic Steps in Development : Statement  of the Problem – Development of a Model – 

Design of an Algorithm – Correctness of the Algorithm – Programme Testing – Documentation. 

 

Block 2:  Growth –of –Function – Summations –Formulas and Properties - Recurrences. 

 

Block 3: Algorithm Design Methods: Basic Problem Solving Methods: Sub goal-Hill-Climbing 

and Working Backward – Example: Jeep Problem -Backtrack Programming: Example: Bicycle 

Lock Problem – Branch and Bound - Example: Traveling Salesman Problem for five-city 

network - Recursion: Example: Factorials and Fibonacci Series - Ackermann’s Function. 

 

Block 4: Complexity Analysis of Sorting and Searching: Sorting: Heap Sort - Bubble Sort-

Selection sort - Quick Sort. Searching: Binary search - Linear Search. 

 

Reference Books: 

 

1. Fundamentals of Computer Algorithms, Ellis Horowitz and Sartaj Sahni, Galgotia 

Publications. 

2. Introduction to the Design and Analysis of Algorithms, S.E. Goodman and, S.T. 

Hedetniemi. 
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BSCS-09:  Object Oriented Programming with C++ 

 

Block-1 : C++ Fundamentals: Object Oriented Programming  - Programming Paradigms – 

Benefits and Concepts – Advanced Concepts – OOP languages – Overview of C++ - Structure of 

a C++ Program – Header Files - Keywords – Tokens and Identifiers – Compiling – Running C++ 

programs - Constants and Variables: Data Types – Integer – Float – Char – Double – Pointer – 

Variable and Constant declarations – Macro definitions – Reference variables – Complex 

variables – Type conversions – Type casting – Storage classes : auto, register, static, extern - 

Input and Output:  Stream I/O –  I/O Manipulators – Creating I/O manipulators – IOS flags – 

Stream buffer class hierarchy. 

 

Block-2 : Programming Constructs : Operators: Arithmetic – Relational – Logical – Assignment 

– Pre and Post Increment & Decrement – Bitwise – Scope Resolution :: operator –  

?(conditional) – Value operator – Member operator – Indirection operator – new and delete 

operator – Precedence rules – Control structures: if – else – if elseif ladder – switch case -  

Iterative constructs - Loops – for loop – while loop – do while loop – Initialisation – exit 

condition – increment/decrement for three loops compared – Nesting loops – Creating infinite 

loops – break and continue statements – goto statement and labels. 

 

Block-3: Data Structures: Arrays: Single Dimensional arrays - Declaration – Initialization – 

Multi-Dimensional arrays – Declaration – Initialization – Addressing method – Subscripts – 

Character arrays – Initialization – Null Character – Multi-dimensional character arrays – 

Structures: – Declaration – Definition – Bitfields – Array of structures – Structure containing 

arrays – Pointer to structures – Structures versus unions – Anonymous unions. 

 

Block – 4 : Structured and Object Oriented Programming : Functions: Structured Programming – 

Function definition & declaration – Parameters – Arguments – Return Values – void – Call by 

value parameters – Call by reference parameters – Passing arrays – Passing structures – Passing 

a function to another function – Pointer to function – Recursive function – Classes : and Objects 

– Visibility Labels – private, public and protected – Data members – Member functions –  Object 

declaration and accessing members – Passing objects to functions – Returning objects – 

Constructor function – Destructor function – friend functions – static data and function members 

– Inline functions versus macros – Overloading: Compile-Time Polymorphism – Function 

overloading – Rules for function overloading – Operator overloading – rules for operator 

overloading -   Function templates – Class templates – Extensibility – Reusability – Inheritance – 

Run-Time Polymorphism – Virtual functions- Files: fstream header file - text and binary files 

creation and access – random access in files – storing objects in files – command-line arguments 

to main() function – Exception handling – Unified Modeling Language (UML) – Context 

Diagrams. 

Reference Books: 

1. Object Oriented Programming with C++, E. Balagurusamy, McGraw Hill, 2006 

2. Let us C++, Yaswant Kanetkar, BPB Publications 

3. Object Oriented Programming in C++, N.Barkakati, PHI. 
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BSCS-10:  Introduction to Database Management Systems 

    

Block 1  :  DBMS concepts : Introduction – Basics of Database – Three views of Data – Three 

level architecture of DBMS – Facilities – Elements of DBMS – Advantages and disadvantages –

File Management system and its drawbacks – Database Models: E-R Model-Hierarchical Model-

Network Model- Relational Model. 

 

Block 2:  File Organization: Introduction – Methods of File Organization – Sequential, Direct, 

Index Sequential – Multi Key file organization – Management Considerations: Objectives – 

Conversion – Evaluation of DBMS – Administration of DBMS. 

 

Block 3:  RDBMS and DDBMS:  Introduction – Relational Model – Concept – Definition of a 

relation – Relational algebra and relational completeness – Normalization: Objectives – 

Functional dependency – Anomalies in a database – Properties of Normalization – Various 

Normalization techniques – Examples of database design  

 

Block 4: SQL: Types of SQL commands – Data definition – Data Manipulation statements – 

Distributed Databases: Structure of Distributed database – Design of Distributed database. 

 

 

Reference Books: 

1. Database System Concepts, Abraham Silberschatz, Henry F. Korth, S. Sudarshan, McGraw-

Hill, 1999. 

2. An Introduction to Database systems, Bibin C. Desai, Galgotia Publications.1998. 

3. Fundamentals of Database Systems, Elmasri & Navathe, 5th Edition, Addison Wesley, 2006. 

4. An Introduction to Databases Systems, C.J. Date, A. Kannan, S.Swamynathan, Pearson 

Education, 2008. 
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CCE: ENVIRONMENTAL STUDIES 

Block 1: The Multi disciplinary nature of environmental studies - Definition, scope and 

importance - Need for public awareness. 

Block 2: Natural Resources - Renewable and non- renewable resources - Natural resources and 

associated problems. 

a. Forest resources: Use and over-exploitation, deforestation, case studies. Timber extraction, 

mining, dams and their effects on forests and tribal people. 

b. Water resources: Use and over – utilization of surface and ground water, floods, drought, 

conflicts over water, dams – benefits and problems. 

c. Mineral resources: Use and exploitation, environmental effects of extracting and using 

mineral resources, case studies. 

d. Food resources: World food problems, changes caused by agriculture and overgrazing, 

effects of modern agriculture, fertilizer-pesticide problems, water logging, salinity case studies. 

e. Energy resources: Growing energy needs, renewable and non renewable energy sources, use 

of alternate energy sources. Case studies. 

f. Land resources: Land as a resource, land degradation, man induced landslides, soil erosion 

and desertification. 

Role of an individual in conservation of natural resources - Equitable use of resources for 

sustainable lifestyles. 

Block 3: Ecosystems - Concept of an ecosystem - Structure and function of an ecosystem - 

Producers, consumers and decomposers - Energy flow in the ecosystem - Ecological succession - 

Food chains, food webs and ecological pyramids - Introduction, types, characteristic features, 

structure and function of the following ecosystem:- 

a. Forest ecosystem 

b. Grassland ecosystem 

c. Desert ecosystem 

d. Aquatic ecosystems (ponds, streams, lakes, rivers, oceans, estuaries) 

Block 4: Biodiversity and its conservation - Introduction – Definition : genetic, species and 

ecosystem diversity - Biogeographical classification of  India - Value of biodiversity : 

consumptive use, productive use, social, ethical, aesthetic and option values - Biodiversity at 

global, National and local levels - India as a mega – diversity nation - Hot-spots of biodiversity - 

Threats to biodiversity : habitat loss, poaching of wildlife, man wildlife  conflicts - Endangered 

and endemic species of India - Conservation of biodiversity : In-situ and Ex-situ conservation of 

biodiversity. 

Block 5: Environmental Pollution - Definition - Causes, effects and control measures of : Air 

pollution, Water pollution, Soil pollution, Marine pollution, Noise pollution, Thermal pollution, 

Nuclear hazards - Solid waste Management - Causes, effects and control measures of urban and 
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industrial wastes. - Role of an individual in prevention of pollution - Pollution case studies - 

Diaster management: floods, earthquake, cyclone and landslides. 

Block 6: Social issues and the Environment - From Unsustainable to Sustainable development - 

Urban problems related to energy - Water conservation, rain water harvesting, watershed 

management - Resettlement and rehabilitation of people; its problems and concerns. Case studies 

- Environmental ethics: Issues and possible solutions - Climate change, global warming, acid 

rain, ozone layer depletion, nuclear accidents and holocaust. Case studies - Wasteland 

reclamation - Consumerism and waste products - Environment Protection Act - Air (Prevention 

and Control of Pollution) Act - Water (Prevention and control of Pollution) Act - Wildlife 

Protection Act - Forest Conservation Act - Issues involved in enforcement of environmental 

legislation - Public awareness. 

Block 7: Human Population and the Environment - Population growth, variation among nations - 

Population explosion  - Family Welfare Programme - Environment and human health - Human 

Rights - Value Education - HIV / AIDS - Women and Child Welfare - Role of Information 

Technology in Environment and human health - Case Studies. 

 

 

 

 

 

 

 

 

 

 

 

 

BSCS P2: Lab 2- C++ Programming and RDBMS  
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THIRD YEAR 

 

BSCS – 15:  Data Communications and Networking 

 

Block-1: Data Communication: Components- Data   Representation – Data Flow, Networks: 

Distributed Processing- Network criteria- Physical Structures – Network Models – Types of 

Networks - Protocols and Standards. 

Block-2: Layered Tasks: OSI Reference models – TCP/IP Protocols – Addressing – Data and 

Signals: Analog and Digital – Periodic and Non periodic signals – Periodic Analog Signals. 

Block 3: Transmission media: Guided media: Twisted pair Cable – Coaxial Cable – Fiber Optic 

Cable, Unguided media: Wireless- Radiowaves – Microwaves-Infrared. 

Block 4: Network devices: Connecting Devices: Passive Hubs- Repeaters- Active Hubs- Bridges 

– Two layer Switches – Routers – three layer switches – Gateways. Logical Addressing: IPv4 – 

IPv6. 

Reference Books: 

 

1. Data communications and networking, Behrouz A. Forouzan, Tata McGraw Hill, 2007. 

2. Computer Networks, Andrew S.Tanenbaum, Prentice-Hall of India, New Delhi, Third 

Edition, 2003. 

3. Data and Computer Communications, William Stallings, Prentice Hall, 2000. 

4. Computer Networking with Internet Protocols and Technology, William Stallings, 

Pearson/Prentice Hall, 2003. 
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BSCS-16:  Introduction to Operating Systems 

 

Block 1: Fundamentals of Operating System: Introduction: What is an operating system – 

History of operating systems – Operating system concepts – System calls – Operating system 

structure-Process Management: Introduction to processes. 

 

Block 2: Inter-process Communication: Race conditions – Critical sections – Mutual exclusion – 

Semaphores – Event counters – Monitors – Message Passing - Process Management : 

Introduction - Round robin scheduling – Priority Scheduling – Multiple queues – Shortest job 

first – Policy driven scheduling – Two level scheduling. 

 

Block 3: Deadlocks: Resources – Deadlock modeling – Detection and Recovery – Deadlock 

Prevention – Avoidance. 

 

Block 4: Memory Management: Memory management without swapping or paging: 

Multiprogramming without swapping or paging – Multiprogramming and Memory usage – 

Multiprogramming with fixed partitions - File Management: File basics – Directories – Disk 

space management – File storage – Directory structure.  

 

 

Reference Books: 

 

1. Operating System Concepts, Abraham Silberschatz, Peter B. Galvin, Contributor Peter B. 

Galvinm, Addison-Wesley, 1994. 

2. Operating system Design and Implementation, Andrew S. Tanenbaum – PHI, 1987. 

3. Operating  System, Milan Milankovic, McGraw Hill.1987. 
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BSCS-17:  Java Programming  

 

Block 1:  Fundamentals of Java Programming: Internet Programming: Introduction – 

Fundamentals of Java - Applets and Applications – Features of JAVA – JVM – Java API - Java 

libraries – Structure of a Java program - Java variables – Constants - Java data types – Operators 

– Keywords – Type Casting. 

 

Block 2 : Java Programming Constructs : Statements : if – if else if – for – while – do while – 

switch case – break – continue - go to – Simple Java programs.  Arrays: one dimensional – 

multidimensional – Initialisation of arrays – Simple programs. Classes – Objects – Constructor: 

default – parameterised   - copy.  

 

Block 3 : Subclassing and Exception Handling : Subclassing – abstract class – extends keyword 

– instanceof operator – final keyword – static variables and methods – Access specifier – 

Wrapper classes – Inner classes – Simple programs -  Exception Handling : Exception classes – 

try and catch – multiple exceptions – built-in exceptions - using finally – throw – catching 

exceptions – user defined exceptions.   

 

Block 4: Packages and Interfaces: Packages – creation – Adding classes to existing package – 

Interfaces – creation and implementation – Features – Object Oriented Programming in Java - 

Applet Programming: Applet creation – execution – GUI creation – Designing layouts – 

Multithreading – Simple Programs. 

 

 

Reference Books: 

 

1. Java Programming a Primer, 3e, Dr.E.Balagurusamy. Tata McGraw-Hill,   

2. The Java Handbook, Patrick Naughton, Osborne McGraw-Hill, 1996 
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BSCS-18: HTML & WEB DESIGN 

 

Block 1: Introduction to HTML: manipulating and formatting HTML text: HTML terminology 

overview- Tags and attributes – Absolute and relative URLs – Basic Font manipulation 

techniques – Advanced text formatting. 

 

Block 2 : Placing and Manipulating Images: Working with the <img> Tag – Working with 

Image Alternate text – Image and Text Formatting – Adding Space around an Image – 

manipulating Images in an HTML Editor. Working with Page Layout: Page background Image – 

setting a background Image. 

 

Block 3: Creating and manipulating Tables: Table basics – Configuring Specific Table attributes 

– Nesting Tables within tables. 

 

Block 4: HTML Editor: Creating a FrontPage Web – The File Menu – The Edit Menu – The 

View Menu – The Insert Menu – The Format Menu – The Tools Menu – The Table Menu – The 

Frames Menu. Web Casting Techniques: Introduction – Search Engine – Search tools – 

Subscribing – Channels - Channels Push technology. 

 

Reference Books:  

 

1) HTML Professional Projects, John W. Gosney, Eswar Press. 

2) Internet and Web Technologies, Raj Kamal, Tata McGraw- Hill. 2002 
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BSCS-19:  Introduction to Software Engineering 

 

Block 1: Software Engineering Concept: Definition – Software Product – Components and 

characteristics – Phases in Software development – Software Process Models: Linear Sequential 

– Prototyping – RAD – Spiral – Incremental – Formal methods – Fourth generation techniques. 

 

Block 2 : Project Management Concepts : People – Product – Process – Project Development 

Team Structures -  Software Crisis – Role of System Analyst – Project planning and control : 

Planning objectives – Software scope – Resources – Project Estimation – Decomposition 

Techniques – Estimation Models – Project standards – Outsourcing – Risk Management : Risk – 

Identification – Projection – Refinement – Mitigation. 

 

Block 3: Project Scheduling and Tracking: Basic concepts – Defining task set for the software 

project – Scheduling Plan – Software Quality Assurance: Quality concepts – Quality Assurance 

Activities – Software Reviews – Formal Technical Reviews – Software Reliability – ISO 9000 

quality standards – Software Configuration Management.  

 

Block 4 : Software Analysis, Design and Testing : Analysis concepts and principles – Software 

prototyping – Specification Modeling and Information flow – Behavioural Modeling – Design 

Concepts and principles – Modular design – Architectural design and process – User Interface 

design – Software Testing : Principles – Test case design – White Box test – Block box testing – 

Testing Strategies : Unit – Integration – Validation – System – Art of debugging – Case study. 

 

Reference Books: 

1. Software Engineering: A Practitioner's Approach, Roger S. Pressman, McGraw-Hill, 

2004. 

2. Software Engineering, Ian Sommerville, Addison-Wesley, 2007. 

 

 

 

 

 

 

 

BSCS - P3: Lab 3: Java Programming  

 

BSCS – P4: Project Work 
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ELECTIVE I 

 

BSCS-11:  Accounting and Financial Management 

 

Block 1: Fundamentals of Accounting: Principle of Accounting – Accounting and its Function: 

Double Entry Book Keeping – Journal – Rules of Journalising – Ledger – Trial Balance – 

Rectification of Errors – Trading Profit and Loss Account – Balance Sheet. 

 

Block 2 : Financial concepts : Financial Statement – Nature of Financial Statements – 

Limitations of Financial Statements – Types of Analysis – Tools of Analysis – Trend Analysis – 

Comparative Statement.  

 

Block 3: Ratio Analysis: Types of Ratio – Factors affecting efficiency of Ratio – Limitations of 

Ratio – Fund Flow Analysis – Cash Flow Analysis. 

 

Block 4: Methods of Costing and Budgeting: Marginal Costing – Break even analysis – 

Application of Marginal Costing – Limitations – Budgeting: Importance of Budgeting – Budget 

factors.  

 

 

Reference Books: 

 

1. Advanced Accountancy, R.L.Gupta, and M.Radhasamy, Sultan Chand & Sons. 

2. Principles of Management Accounting, Man Mohan and Goyal. 

3. Studies in Cost Accounting, P. Das Gupta, Premier Book company. 
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BSCS – 12: Management Information Systems  

 

Block 1: Introduction to MIS: Concept, Definition, Role, Impact, Importance, MIS and Uses. 

Approaches to management, Functions of Manager, Manager and the environment, Management 

as a control System. 

 

Block 2: Types of Information Systems: Decision Making, Concepts- Methods, Functions of 

DSS, Executive information System, MIS, TPS, ES. 

 

Block 3: Business Information System: Functional Information Systems- Marketing Information 

– Manufacturing Information System- Quality Information System, Financial and Accounting 

Information System- Human Resource Information System. 

 

Block 4: System Development Life Cycle & Tools for IS Development: System Development- 

System Analysis, System Design, System Development Life Cycle, Preliminary Investigation- 

Tools for System Development – DFD- Data Dictionary- Decision Trees. 

 

References Books: 

1. Management Information System, W. S. Jawadekar , Tata Mcgraw hill 

2. Management Information System A Managerial Perspective, Uma G. Gupta, Galgotia 

Publications Pvt. Ltd. 1998 
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BSCS-13: Principles of Management 

 

Block 1: Management – Features, Functions – Management as an art, Science, Profession – 

Evolution of management thoughts. 

Block 2: Planning – Process, Importance, Nature and Scope, Types, Steps in Planning. 

Objectives, Policies, Procedures, Strategy- Decision making: Types of decisions, difficulties in 

decision making – Management by Objectives. 

Block 3: Organising – Features, Importance – Principles of organizations – Types – Organisation 

structure – Delegation – Span of control – Line and staff relationship – Use of staff units and 

committees. 

Block 4: Staffing – Sources of recruitment – Selection process – Training. Directing – Nature 

and purpose – Communication process. 

Block 5: Need for Coordination – Controlling – Importance and functions of control – Control 

process – Budgetary and non- budgetary control. 

Reference Books: 

1. Management Process, Rustom Davar 

2. Principles of Management, L.M. Prasad 

3. Business Management, Dinkar & Pagare 

4. Essentials of Management, Koontz & O Donnell 

5. Principles of Management, Sherlekar 
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BSCS – 14: Managing Information Technology 

 

Block 1: Roles of Information Technology (IT): Roles of Chief Information Officer (CIO) as 

Chief Technical Officer (CTO) – Chief Asset Officer (CAO) – Chief Knowledge Officer (CKO) 

 

Block 2: IT / CIO and Promotion of Enterprise Innovation: A Framework for Enterprise 

Innovation by IT – Business Innovation by IT – Product Supply Innovation by IT – Management 

Innovation by IT – Promotion of Enterprise Innovation by IT 

 

Block 3: IT Strategies: Information System Architecture – Important IT Techniques and Trends 

– Construction of Information System Architecture. 

 

Block 4: CIO and Management of IT Management: Framework for IT Management – IT Asset 

Management – IT Process Management – System Cost Management – Innovation Strategies for 

IT Organisation – Management of IT Outsourcing. 

 

Block 5: Preparation and Development of IT Master Plans: Case Studies Preparation and 

Development of Security Policy: Overview of Computer Security – Risk Assessment – Security 

Policy - Managing Information Systems. 

 

Reference Books: 

1. Strategic Planning for Information Systems, J. Ward and P. Griffiths 

2. The Art of Strategic Planning for Information Technology, B.H. Boar 

3. Managing in a Time of Great Change, P. Drucker 

4. The Rise and Fall of Strategic Planning, H. Mintzberg 
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ELECTIVE II 

 

BSCS-20: Network Security 

 

Block-1: Introduction: Security attacks, Security services and mechanism-model for network 

security-classical Encryption techniques - Symmetric cipher model - Substitution techniques-

Transposition techniques & Steganography. 

 

Block-2: Principles of modern symmetric ciphers: Block cipher principles - feistel cipher 

structure – DES - Encryption & Decryption, Differential & linear crypt analysis - AES. 

 

Block-3: Public key encryption: Public key cryptography & RSA-Basics of number theory - 

RSA algorithm - key management - Diffe Hellman key exchange - Elliptic curve cryptography 

 

Block-4: Message Authentication & Hash function: Authentication requirements – 

Authentication function- message Authentication codes - Hash function & security of hash 

function of MACs. 

 

 

Reference Books: 

  

1. Cryptography and Network Security Principles and Practices, William Stallings, fourth 

edition, Pearson Prentice Hall, 2008. 

2. Information Security,  Theory and Practice, Dhiren R.Patel , PHI 2008 

3. Network Security, The Complete reference, Roberta Bragg, Mark Rhodes – Ousley, Keith 

strassberg , Tata McGraw Hill Edition, 2007.  
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BSCS-21: Software Testing 

 

Block 1: Software Quality Assurance: software challenge - Software Quality – Software Quality 

factors – Software Quality Models- Software quality measurement and metrics – Software 

Quality Architecture. 

 

Block 2: Introduction to Software Testing: Overview- Purpose of testing – Objectives – 

Inspection and Testing – Testing and debugging – Debugging process – Software testing life 

cycle – Responsibility of test team leader. 

 

Block 3: Testing techniques: The V-Model – Testing techniques: Functional testing techniques – 

Non-functional testing techniques- Test metrics- Risk based testing – Extreme testing.  

 

Block 4: Automated testing: Introduction – process - Types of automated test – Code auditing – 

Coverage Monitoring – functional test – Load test – Test Management - Advantages and 

Disadvantages of Automated test - Alpha and Beta site testing programs. Test Maturity Model: 

Human Issues and Challenges in testing. 

 

Reference Books: 

1. Software Quality Assurance, Nina S Godbole, Narosa Publishing House, 2008. 

2. Software Quality Assurance, From Theory to Implementation, Daniel Galin, Pearson 

Education, 2004. 

3. Software Quality Complete and Practices, R A Khan, K. Mustafa, SI Ahson , Narosa 

Publishing House, 2008. 

4. Software Testing principles and Practices, Srinivasan Desikan, Gopalswamy Ramesh, 

Pearson Education, 2006. 
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BSCS-22: Compiler Design 

 

Block 1: Introduction: Structure of complier- Roles of Lexical Analyzer- Tools-Regular 

Expressions- Symbol table- Error handling - Automata Concepts: Finite automata, Regular 

Expression to finite automata, Non-deterministic finite automata- Minimizing states of DFA. 

 

Block 2: Parsing Techniques: Parser, Ambiguity, Shift reduce parsing, Operator precedence 

parsing, top down, Predictive parsing  

 

Block 3: Intermediate code: Intermediate code, Postfix notation, Parse trees, Address code, 

Quadruples, and Triples. 

 

Block 4: Optimization techniques: Principles of source of optimization, loop optimization, DAG 

representation of basic block, Other loop optimization techniques. 

 

 

Reference Books: 

1. Complier Principles, Techniques and Tools- Alfred V. Aho, Jeffery D. Ullman, Ravi 

Sethi, Wesley Publishing Company, 1986. 

2. Principles of Complier Design - Alfred V. Aho, Jeffery D. Ullman, Narosa Publishing 

House, 1996. 

3. Introduction to System Software, D.M. Dhandhere, Tata Mcgraw Hill, 1986 
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BSCS-23:  TCP/IP Programming 

 

Block 1: Introduction to TCP/IP:  Introduction – TCP/IP layering – TCP/IP Stack : TCP level – 

IP level – Ethernet level – Internet Addressing: IP Address Format – IP address classes – 

Domain Name System (DNS) - Characteristics – DNS message format – Client Server Model. 

 

Block 2: Internet Protocol (IP): Definition – IP Header – Structure – Components – IP Address – 

IP Address components – Formats and Classes – IP Routing – IP subnet addressing – subnet 

mask. 

 

Block 3: Transmission Control Protocol (TCP):  Introduction – Basic Terminology   - TCP 

Header – Structure – Components - Features of TCP. 

 

Block 4: User Datagram Protocol (UDP) – Terminology – UDP Header – Structure – Format – 

Characteristics of UDP – Features of UDP, Internet multi casting – TCP/IP over ATM networks 

– Client Server model of Interaction Socket Interface. 

 

Reference Books: 

 

1. Internetworking with TCP/IP Volume – I, Principles, Protocols and Architecture, 

Douglas E. Comer 

2. TCP/IP: Architecture, Protocols and Implementation, S.Felt, WCB / McGrawHill. 

3. Introduction to TCP/IP , Forouzan, McGraw Hilll, 1999. 
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BSCS-24: Intranet Administration 

 

Block 1: Intranet Fundamentals: The Intranet – Definition – How Intranet works? – Internet Vs 

Intranet – Advantages of Intranet – Types of Intranet : Bulletin board – Database management – 

Information access – The communications Intranet – Integrating Intranet – Catalogue Intranet – 

Sing Sign-On Intranet – Software and Hardware requirement for Intranet – Application areas – 

Future of Intranet. Intranet’s Security: Security concerns – Threats – Security Solutions: 

Hardware – Software – Information – Certification – Firewalls – Encryption / decryption 

methods – Security policy – Multiple Layers of Intranet security – SOCKS – Advise from 

Security Experts. 

 

Block 2 : Selection of Computing Infrastructure for Intranet – Hardware: Servers – Clients – 

Security Systems – Network Environment : LAN – Address Translation – Firewall – Software : 

Operating System – Groupware – Database connectivity - ODBC – JDBC – Other Aspects: 

Protocol Support Tools – Web based Tools : HTML, XML, CGI – Web authoring tools – 

Security tools: Firewalls – Virtual Private Network – Encryption/decryption using by SSL. 

 

Block 3 : Configuring Intranet : Web  authoring Preview – Web graphics – Adding Interactivity 

– Installation : Network installation and administration – User management – Disk quotas – 

Security configuration and Analysis – Account Policies – Permissions and restrictions – Tuning 

server performance – Configuring network settings – Networks and Security – Tuning 

applications over Intranet.  Intranet Authoring and Managing tools: Authoring tools: Editors – 

Supporting applications for service – Graphical tools for creating and animating – Management 

tools: Databases – basic – ODBC – distributed – Web Servers – other tools.  

 

Block 4 : Intranet Protocols: Communication cum mail protocols : ARP – SMTP – POP – IMAP 

– Service protocols: TCP – IP – TELNET – HTTP – FTP – UDP – Web server specific protocols 

– CGI – ISAPI – NSAPI – DMSP – Latest protocols : CDMA – WAP – GPRS – Protocols for E-

Commerce. 

 

Reference Books: 

 

1. David Linthicum’s Guide to Client/Server and Intranet Development, David. S. 

Linthicum, John Wiley & Sons. 

2. Intranet’s Decisions : Creating your organization’s internal network, Lisa Kimball, Miles 

River Press 

3. Designing the Total Area Network: Intranets, VPN and Enterprise Networks Explained, 

Steve Pretty, John Wiley & Sons. 
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